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Documentation Conventions

OPNET documentation uses specific formatting and typographic conventions to present 
the following types of information:

• Objects, examples, and system I/O

• Object hierarchies, notes, and warnings

• Computer commands

• Lists and procedures

Objects, Examples, and System I/O

• Directory paths and file names are in plain Courier typeface:

opnet\release\models\std\ip

• Function names in body text are in italics:

op_dist_outcome()

• The names of functions of interest in example code are in bolded Courier 
typeface:

/* determine the object ID of packet’s creation module */
src_mod_objid = op_pk_creation_mod_get (pkptr);

• Variables are enclosed in angle brackets (< >):

<opnet_user_home>/op_admin/err_log

Object Hierarchies, Notes, and Warnings

Menu hierarchies are indicated by right angle brackets (>); for example:

Open File > Print Setup > Properties...

Attribute hierarchies are represented by angled arrows (➘ ) that indicate that you must 
drill down to a lower level of the hierarchy:
AG-FM-iv IT Guru/Release 11.0



Administrator Guide Documentation Conventions
Attribute level 1 ➘ Attribute level 2 ➘ Attribute level 3

Note—Notes are indicated by text with the word Note at the beginning of the 
paragraph. Notes advise you of important supplementary information.

WARNING—Warnings are indicated by text with the word WARNING at the 
beginning of the paragraph. Warnings advise you of vital information about an 
operation or system behavior.

Computer Commands

These conventions apply to Windows systems and navigation methods that use the 
standard graphical-user-interface (GUI) terminology such as click, drag, and dialog box.

• Key combinations appear in the form “press <button>+x”; this means press 
the <button> and x keys at the same time to do the operation.

• The mouse operations left-click (or click) and right-click indicate that you 
should press the left mouse button or right mouse button, respectively.

Lists and Procedures

Information is often itemized in bulleted (unordered) or numbered (ordered) lists:

• In bulleted lists, the sequence of items is not important.

• In numbered lists, the sequence of items is important.

Procedures are contained within procedure headings and footings that indicate the start 
and end of the procedure. Each step of a procedure is numbered to indicate the 
sequence in which you should do the steps. A step may be followed by a description of 
the results of that step; such descriptions are preceded by an arrow.

Procedure FM-1 Sample Procedure Format 

1 Procedure step.

➥ Result of the procedure step.

2 Procedure step.

End of Procedure FM-1

For more information about using and maintaining OPNET documentation, see the 
OPNET IT Guru Documentation Guide.
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Server.

• Added information about License File Format Conversion.

August 2004 11.0 License Manager • Changed data type of license_http_proxy_password and 
license_password preferences.

License Server • Added information on loan authorization files in Restricting 
Loanable Licenses.

March 2004 10.5 PL1 Installation Support • Corrected the command line in Procedure 2-8 Updating from a 
Previous Release (UNIX) on page AG-2-10

• Deleted obsolete procedures for installing OPNET in a different 
directory (WIN and UNIX)

January 2004 10.5 PL0 License Manager • Added preferences license_http_proxy_password, 
license_http_proxy_user, and manage_loanable_licenses.

August 2003 10.0 PL1 License Manager • Added loanable license operations: Extend On-Loan License 
(button), Change Authorized Loan Duration (button), and 
Change Loan Properties (button).

January 2003 10.0 ALL • First Issue
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1 Basic Concepts

This manual contains installation support information and a description of the 
OPNET license system. The information and procedures in this manual are for 
system administrators or IT Guru users who install and maintain computing 
environments in UNIX or Windows operating systems, and need to do the 
following tasks:

• Install new user accounts

• Update the IT Guru software

• Relocate IT Guru software

• Use the license system

What You Need to Know

To do the administrator tasks described in this manual, you need to know the 
following concepts and techniques:

• For UNIX installations

— techniques of becoming super-user: su, login, rlogin

— disk partition, directory, file, and path name concepts

— Network Filesystem (NFS) concepts

— C shell usage and conventions

— host workstation directory organization

— basic directory and file commands: cd, mkdir, chmod, chown

• For Windows installations

— techniques of becoming administrator (Windows)

— disk partition, directory, file, and path name concepts

— command interpreter usage and conventions

— host workstation directory organization

— basic directory and file commands: cd, mkdir

If you are not familiar with these concepts, you may want to obtain the 
assistance of an in-house system administrator familiar with UNIX or Windows. 
Alternatively, you may prefer to develop the necessary skills yourself, either by 
acquiring a beginning text or attending a beginning class.
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Terminology

architecture
directory

An architecture-specific system directory within a particular IT Guru release. 
IT Guru executables and libraries are typically stored in this directory. 
Architecture directories are subdirectories of the sys directory of a particular 
release. In this manual, the symbol <arch> represents an architecture 
directory. The following table lists the names used for this directory under the 
various architectures supported by IT Guru.

binary directory A directory containing the IT Guru binaries. The binaries for a specific release 
and computer architecture are located in <reldir>/sys/<arch>/bin. 
Under UNIX a special binary directory contains scripts that allow IT Guru to 
locate the binaries for the platform being used.

In this manual, the symbol <bindir> represents the path to a binary directory. 
For example, if IT Guru 11.0.A is installed in the directory /usr/opnet, then 
<bindir> represents the Solaris path name

/usr/opnet/11.0.A/sys/sun_sparc_solaris/bin

or the Windows path name

\opnet\11.0.A\sys\pc_intel_win32\bin

CD-ROM directory;
CD-ROM drive

The mount point for the CD-ROM drive of the install workstation. The symbol 
<cd_dir> represents the CD-ROM directory in this manual. (Under Windows, 
the CD-ROM drive will be mounted at a particular drive letter, rather than a 
directory. The symbol <cd_drive> represents the drive letter of the CD-ROM 
drive.)

client workstation A workstation used to execute IT Guru programs. Each client workstation must 
have access to the IT Guru directory, either on its local disk, on a server disk, or 
via the Network Filesystem (NFS).

Table 1-1   Architecture Directory Names

Vendor CPU
Operating 
System <arch> Directory Name

Sun Microsystems SPARC Solaris sun_sparc_solaris

various various all UNIX systems unix

various Pentium Windows pc_intel_win32
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install workstation A workstation with a compatible CD-ROM drive. This workstation must be able 
to mount the server workstation disk partition containing the OPNET directory 
via the Network Filesystem. At many sites, the server workstation has a 
CD-ROM drive and is therefore also the install workstation. At completely 
stand-alone sites, a single workstation fills all three roles: client, server, and 
install workstation.

library directory A directory containing the IT Guru libraries. The libraries for a specific release 
and computer architecture are located in <reldir>/sys/<arch>/lib.

In this manual, the symbol <libdir> represents a library directory. For 
example, if IT Guru is installed in the directory /usr/opnet under Solaris, then 
<libdir> represents the directory path name 
/usr/opnet/11.0.A/sys/sun_sparc_solaris/lib.

licensing system The licensing system allows you to run IT Guru or another licensed application 
on any workstation on the local network. See Chapter 3 License Manager on 
page AG-3-1 for a description of the important components of this system.

OPNET directory The directory in which the IT Guru system software is or will be loaded. You can 
choose where to place IT Guru in the directory tree; almost any location will 
work. However, because the IT Guru system software occupies a significant 
amount of disk space, the disk partition holding the OPNET directory must have 
enough free space before installation begins (refer to the OPNET web site to 
determine the amount of partition free space required).

A typical location for the OPNET directory is:

Windows: C:\Program Files\Cisco

The symbol <opnet_dir> represents the OPNET directory. Typically, there 
is only one path name to the OPNET directory. Different subdirectories within 
the OPNET directory may contain different releases of the IT Guru software.

release CD-ROM The distribution media supplied as part of the IT Guru release materials.

release directory A directory containing the software for a particular IT Guru release. Release 
directories are subdirectories of the OPNET directory. In this manual, the 
symbol <reldir> represents the release directory. 

server workstation The workstation that stores the OPNET directory on its disk. A server 
workstation may also be a client workstation. More commonly, however, a 
server workstation is a file server that is shared by a workgroup.
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2 Installation Support

This chapter provides information that supports the basic IT Guru installation 
instructions provided on the installation sheets. This information includes the 
following:

• Installation troubleshooting suggestions

• Procedures for updating or moving existing software

• Procedures for running previous releases

• Procedures for removing and relocating software

In most cases, you won’t need the information contained here. It is provided for 
any special cases that might arise.

For information about supported platforms, memory usage, and other 
requirements, visit the Technical Support area of the OPNET website at 
(www.opnet.com/support).

UNIX Installation Support

Most sites should follow the installation procedure described on the UNIX 
Installation sheet. This procedure uses the installation program to configure 
your workstation automatically and install IT Guru. However, if your workstation 
has an unusual or incorrect configuration, the installation program may fail. If so, 
you can use the information here to solve the problem.
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UNIX Installation Troubleshooting

This section provides solutions for problems that may occur during UNIX 
installations. Each problem has a discussion section that explains what is 
happening and a solution section that explains how to solve the problem. If your 
problem is not described here, contact Technical Support for help.

Problem Attempts to run programs that use IT Guru libraries result in “No such file or 
directory” errors.

Discussion The PATH environment variable must be set to include the correct IT Guru 
executable directory. Either the variable does not include the IT Guru 
executable directory or it is set for the directory of an earlier release.

Solution Make sure each user has the correct environment path, as follows:

Procedure 2-1   Checking the Environment Path

1 Log in to the user’s account.

2 Open the user’s shell startup file (.cshrc in the C shell).

3 Add the following directory to the user’s PATH variable.

<opnet_dir>/<release>/sys/unix/bin

End of Procedure 2-1
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Windows Installation Support

Most sites should follow the installation procedure described on the Windows 
Installation sheet. This procedure uses the setup program to automatically 
configure your computer and install IT Guru. However, if your computer has an 
unusual or incorrect configuration, the installation program may fail. If so, you 
can use the information here to solve the problem.

WARNING—Changing file systems on Windows platforms, such as from FAT 
to NTFS, will invalidate the license file. To maintain the validity of your licenses 
during a file system change, you should first de-register your licenses, then 
change the file system, and finally re-register your licenses. See Deregistering 
Licenses on page AG-2-11 and Reregistering Licenses After Moving System 
Software on page AG-2-12 for information on how to deregister and re-register 
licenses.

Windows Installation Troubleshooting

This section provides solutions for problems that may occur during Windows 
installations or operation. Each problem has a discussion section that explains 
what is happening and a solution section that explains how to solve the problem. 
If your problem is not listed here, contact Technical Support for help.

Problem Trying to run an OPNET licensed program results in the message: The OPNET 
licensing system depends on the following nonexistent service: Tcpip.

Discussion There is a problem with the TCP/IP software.

Solution Try installing TCP/IP again (as described in Procedure 2-2 on page AG-2-4), 
then repeat the step that failed. If the problem persists, contact OPNET 
Technical Support.

Problem Issuing the sup_info command in the op_license_util program produces 
the message “Ipc Port Entry (0) currently holds no addr” or a similar error.

Discussion There is a problem with the TCP/IP software.

Solution Try installing TCP/IP again (as described in Procedure 2-2 or Procedure 2-3), 
then repeat the step that failed. If the problem persists, contact the OPNET 
Technical Support staff.
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Problem The Windows setup program reports that TCP/IP is not installed.

Discussion The OPNET licensing system requires that the Windows TCP/IP software be 
installed. The TCP/IP software, in turn, requires the presence of an installed 
network adapter driver.

Solution Use the following procedures to install and configure the necessary software:

1) Procedure 2-2 Installing TCP/IP for a Network Connection 
(Windows NT 4.0) on page AG-2-4

or

Procedure 2-3 Installing TCP/IP for a Network Connection (Windows 2000) 
on page AG-2-5

2) Procedure 2-4 Verifying that a Network Adapter Driver is Installed on 
page AG-2-6

3) Procedure 2-6 Configuring TCP/IP on page AG-2-7

To install TCP/IP for a network connection on a Windows NT 4.0 computer:

Procedure 2-2   Installing TCP/IP for a Network Connection (Windows NT 4.0)

1 Verify that you are logged on as a user with administrator’s privileges.

2 Insert your Windows CD-ROM into the CD-ROM drive of the install workstation. If 
a Windows CD-ROM window opens, close it.

3 Open the Windows Control Panel and double-click the Network icon.

➥ The Network (Network Settings) dialog box opens.

4 In the Network (Network Settings) dialog box, click on the Protocols tab. Then click 
the Add… (Add Software) button.

➥ The Select Network Protocol (Add Network Software) dialog box opens.

5 Select TCP/IP Protocol (TCP/IP Protocol and related components) from the list of 
available software and Click the OK button.

➥ The TCP/IP Setup dialog box opens.

6 If the install workstation is not on a network, answer No to the question about using 
a DHCP server. If the install workstation is on a network, consult your system 
administrator for the correct response.

➥ The Windows Setup dialog box opens, showing the path to the software on the 
CD-ROM.

7 Verify that the path is <CD-ROM_drive>:\i386, where <CD-ROM_drive> is the 
letter of the install workstation CD-ROM drive. Change the path if necessary,.
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8 Click Continue.

➥ The TCP/IP software is installed from the CD-ROM.

9 Click OK, then Close to close the Windows Setup dialog box and return to the 
TCP/IP Setup dialog box.

10 Click on the IP Address tab and enter the IP number, subnet mask, and default 
gateway. (If you do not know these, ask your system administrator.)

11 Click on the DNS tab and enter the host name, domain name and DNS service 
search order. (The latter value is the IP address of your DNS server.)

12 Click OK to reboot your computer.

End of Procedure 2-2

To install TCP/IP for a network connection on a Windows 2000 computer:

Procedure 2-3   Installing TCP/IP for a Network Connection (Windows 2000)

1 Verify that you are logged on as an administrator or a member of the 
administrator’s group.

2 Insert your Windows 2000 CD-ROM into the CD-ROM drive of the install 
workstation. If a Windows CD-ROM window opens, close it.

3 From the Windows Start menu, choose Settings > 
Network and Dial-up Connections.

➥ The Network and Dialup Connections dialog box appears.

4 Double-click on the network connection for which you want install TCP/IP, then 
click Properties.

5 Click the General tab for a LAN connection, or the Networking tab for all other 
connection types.

6 If Internet Protocol (TCP/IP) does not appear in the list of installed components, 
perform the following steps:

6.1 Click Install, then Protocol, then Add.

➥ The Select Network Protocol dialog appears.

6.2 Select Internet Protocol (TCP/IP) from the protocols list, then click OK.

➥ Internet Protocol (TCP/IP) now appears in the list of supported protocols for 
the selected connection.

7 Double-click on the Internet Protocol (TCP/IP) list item to open the Internet Protocol 
(TCP/IP) Properties dialog box.

8 Specify your machine’s IP address.
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If your network is run on a DNCP server, choose Obtain IP address automatically.

If your network is not run on an DNCP server:

8.1 Click Use the following IP address... and enter the IP address, subnet mask, 
default gateway, preferred DNS server, and alternate DNS server.

9 Click Advanced... to open the Advanced TCP/IP Settings dialog box, then click the 
DNS tab. 

10 Enter the DNS suffix in the DNS suffix for this connection field.

11 Click OK to close the Advanced TCP/IP Settings dialog box and return to the 
Internet Protocol (TCP/IP) Properties dialog box.

12 Click OK to close the Internet Protocol (TCP/IP) Properties dialog box.

End of Procedure 2-3

Confirm that a network adapter driver is installed. If not, install a dummy driver. 
To verify that a network adapter driver is installed, perform the following 
procedure.

Procedure 2-4   Verifying that a Network Adapter Driver is Installed

1 If it is not already available, open the Network dialog box.

2 Click the Adapters tab to see if there is at least one adapter in the Network 
Adapters list.

• If there is at least one adapter in the list, continue with Procedure 2-6 Configuring 
TCP/IP on page AG-2-7.

• If there are no adapters in the list, you must install a “dummy” driver. Continue 
with Procedure 2-5.

End of Procedure 2-4

To install a network adapter driver, do the following procedure.

Procedure 2-5   Installing a Network Adapter Driver

1 In the Network (Network Settings) dialog box, click the Add… (Add Adapter) button.

➥ The Select Network Adapter (Add Network Adapter) dialog box opens.

2 Select MS Loopback Adapter from the list of available drivers.

3 Click the OK (Continue) button.

➥ The MS Loopback Adapter Card Setup dialog box opens.
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4 Click the OK button.

➥ The standard 802.3 frame type is selected.

5 If prompted, enter the path to the software:

<CD-ROM_drive>:\i386

➥ The software is installed from the CD-ROM.

End of Procedure 2-5

To configure TCP/IP to work with OPNET, use the following procedure.

Procedure 2-6   Configuring TCP/IP

Note—This procedure may result in numerous error messages about various 
network services. You can ignore these messages.

1 In the Network dialog box, click the Protocols tab.

2 Click the Properties… (Configure) button.

➥ The Microsoft TCP/IP Properties (TCP/IP Configuration) dialog box opens.

3 Enter the following configuration information for the workstation. Your network 
administrator can provide appropriate values for your network.

IP Address—Enter the network address of the install workstation. If the workstation 
is not connected to a network, you can enter any value (1.1.1.1, for example).

4 Subnet Mask—Enter a value appropriate for the install workstation, if one is not 
entered automatically. (With the example IP Address in step 3a, the Subnet Mask 
would be 255.0.0.0.)

5 Default Gateway—Enter the address of the gateway used by the install 
workstation. Again, if the workstation is not connected to a network, you can enter 
any value (use 1.1.1.1 again).

6 Click the OK button.

7 If an alert dialog about adapter cards with an empty primary WINS address 
appears, you can generally continue by clicking Yes. If a problem occurs, consult 
your network administrator.

8 Close the Network (Network Settings) dialog box. Restart the install workstation if 
a dialog box suggesting this appears.

End of Procedure 2-6

The necessary TCP/IP software is now ready for use with the Floating License 
System.
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Update Installation Procedures

You must do an update system installation to install IT Guru on a server 
workstation where an earlier release of IT Guru is installed. A server workstation 
with IT Guru already installed normally has a directory called the OPNET 
directory. This directory has a subdirectory for each installed release of IT Guru.

The update installation will add a new subdirectory to the OPNET directory that 
corresponds to the new release. The new release will continue to use the 
existing license file and OPNET execution permits will remain usable after 
installation.

Running Previous Releases

If you have installed the latest version of the software, you can still run earlier 
releases by creating batch files to set the appropriate system variables 
(Windows) or by updating your PATH (UNIX), as described in the following 
procedures.

To run a previous Windows release, do the following procedure:

Procedure 2-7   Running Previous Releases of OPNET (Windows)

1 Use a batch file to set the opnet_dir, Lib, Path, and Include system variables (a 
batch file is any file with a .bat extension). 

For example, the following batch file could be used to set up an environment for 
version 4.0:

@echo off
set mil3_dir = c:\OPNET
set path = c:\opnet\4.0.A\sys\pc_intel_win32\bin;%path%
set lib = c:\opnet\4.0.A\sys\pc_intel_win32\lib;%lib%
set include = c:\opnet\4.0.A\sys\include;%include%
echo OPNET 4.0.A environment has been set up

When you want to run version 4.0, first run the above batch file in a command 
window (by typing the name of the batch file, including the extension), then issue 
the standard OPNET start-up commands from the same window (such as 
opnet -product itguru.

Note—The latest version of the license server (op_license_server) should be 
running on your machine, regardless of the OPNET version you are running. For 
example, if you run both release 7.0 and release 6.0, you should be running the 7.0 
license server. If you selected the “serve licenses from this computer” option during 
the license configuration portion of the installation, the new license server was 
automatically installed in place of any existing servers.

End of Procedure 2-7
AG-2-8 IT Guru/Release 11.0



Administrator Guide 2—Installation Support
To run a previous UNIX release, do the following procedure:

Procedure 2-8   Running Previous Releases of OPNET (UNIX)

1 Reset your PATH variable for the OPNET version you want to run.

For example, to run version 6.0, you would reset your PATH as follows:

set path=(<opnet_dir>/6.0.A/sys/unix/bin $path)

Note—The latest version of the license server (op_license_server) should be 
running on your machine, regardless of the OPNET version you are running. For 
example, if you run both release 7.0 and release 6.0, you should be running the 7.0 
license server. If you selected the “serve licenses from this computer” option during 
the license configuration portion of the installation, the new license server was 
automatically installed in place of any existing servers.

End of Procedure 2-8
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Removing IT Guru System Software from Your Workstation

Typically, you want to free up the disk space used by an old release when it is 
no longer needed. If you are removing release 6.0 make sure you have 
converted your license file to the 7.0 format. See the installation information 
packaged with the CD or the Technical Support area of the OPNET 
Technologies web site for instructions.

To remove system software from a Windows workstation, do the following 
procedure:

Procedure 2-9   Removing System Software from a Windows Workstation

1 If you are not already, log in as administrator to the machine where the IT Guru 
system software is located.

2 Choose Control Panel > Add/Remove Programs.

3 Select each item that begins with IT Guru, then click Add/Remove.

4 If you do not want to keep your IT Guru models and other data, delete the contents 
of directories <HOME>/<op_admin> and <HOME>/<op_models> and remove the 
directories.

End of Procedure 2-9

To remove system software from a UNIX workstation, do the following 
procedure:

Procedure 2-10   Removing System Software from a UNIX Workstation

1 If you are not already, log in as root to the machine where the IT Guru system 
software is located.

2 Delete the directory containing the IT Guru software (<opnet_dir>/<reldir>).

3 If you do not wish to keep your OPNET models and other data, delete the contents 
of directories <HOME>/<op_admin> and <HOME>/<op_models> and remove the 
directories.

End of Procedure 2-10
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Relocating IT Guru System Software

If you want to move IT Guru system files from one computer to another, the 
simplest method is to uninstall the system software from the old location and 
reinstall it in the new location using the original installation CDs.

To do this, you must deregister licenses, uninstall, and reinstall the system 
software, then reregister the licenses in the new location.

WARNING—IT Guru will be unavailable during the following procedures. To 
minimize disruption, do the relocation operation during a low-use period and 
warn users in advance.

To deregister licenses, do the following procedure:

Procedure 2-11   Deregistering Licenses

1 (Windows only) Log in to the machine where the IT Guru system software is 
located.

2 Launch the License Manager:

Windows:

Select License Manager (Start > IT Guru <program_name>).

UNIX:

Enter the following command:

op_license_manager

➥ The License Manager opens in one window. The IT Guru program opens in 
another window, but has limited functionality.

3 Revoke any licenses that are still in use by selecting the licenses and clicking on 
the Revoke License button.

4 In the License Manager tree-view, choose the server where the IT Guru system 
software is located (it should be the machine you are logged into).

5 Deregister the licenses in that server’s license file:

5.1 Expand the license file icon.

5.2 Select and deregister all of the licenses in the license file by clicking on the 
Deregister License button and following the on-screen prompts.

6 Exit IT Guru.

End of Procedure 2-11
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To relocate the system software, do the following procedure:

Procedure 2-12   Relocating System Software

1 If you are not already, log in as root (or administrator) to the machine where the 
IT Guru system software is located.

2 (Windows only) Select Control Panel > Add/Remove Programs.

3 Select each item that begins with IT Guru, then click Add/Remove.

4 (UNIX only) Delete the directory containing the IT Guru software 
(<opnet_dir>/<reldir>).

5 Reinstall IT Guru in the desired location, using the original CDs. Follow the 
installation procedures outlined on the Installation sheets that were packaged with 
the CDs.

End of Procedure 2-12

To reregister licenses after moving the system software, do the following 
procedure:

Procedure 2-13   Reregistering Licenses After Moving System Software

1 Log in to a user account (or as a user) to the machine where the OPNET software 
is now located.

2 Launch OPNET by typing the following commands (where <program_name> is 
the executable name, such as modeler or itguru):

cd <reldir>/sys/unix/bin/
./<program_name>

3 When prompted, select License Management.

4 Click on the Add License button and follow the on-screen prompts.

End of Procedure 2-13
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3 License Manager

This chapter contains the following main sections:

• License Manager Concepts

• Using the License Manager

• Licensing Preferences

License Manager Concepts

You use the License Manager to maintain application licenses. Typical 
maintenance operations are

• Adding a license

• Extending the expiration or maintenance date of a specific license

• Starting or stopping a license server

• Reviewing usage statistics

The License Manager can oversee multiple servers in a network. Each server 
allocates licenses to one or more clients. IT Guru licenses are floating licenses; 
this means that a pool of licenses is maintained by the server. Any user who can 
access the server can use any free license. Licenses are not pre-assigned to a 
specific user.

The licensing system consists of these parts:

• One or more computers, each running at least one license server. The server 
is a service (on Windows platforms) or a daemon process (on UNIX 
platforms). Each computer has its own file of licenses, called 
license_file.

• Client machines, which request and are granted licenses from a particular 
server. To specify the server queried, configure the license_port and 
license_server preferences in the Preferences fileV 
(cisco_aas_envdb<rel_num>), or specify the preferences when you 
launch the program.

• Licenses, which allow a user to use specific applications (such as IT Guru) 
and modules (such as Multi-Vendor Import). See About Licenses on 
page AG-3-4 for details.

Note—Multiple processes or services can run on one computer; therefore, one 
server can run both licensing processes (one license process per port) and 
broker processes (one broker process per port).
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Figure 3-1 shows a license system for two servers.

Figure 3-1   License Manager Components
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About License Servers

The License Manager shows information about the license servers in the 
network in a tree-view.

Figure 3-2   License Manager Window

The “Host IP address” given for each server is the return address of the IP 
packet received by the License Manager and not necessarily the local 
IP address known by the server. For example, if the server’s “home” IP address 
is 172.16.1.1, but it is behind a firewall and the client is on the other side of the 
firewall, the client view of the return address will be the firewall IP address (such 
as 12.54.1.2).

The “Requested server” branch shows the server from which the IT Guru 
program is configured to request licenses. You specify this server by listing the 
server name and port in your Preferences file or by launching the program with 
the -license_server and -license_port licensing preferences. A 
command line preference overrides the matching preference in Preferences. 
This means that if the value for license_server in the Preferences file is “xxx” 
and the command line preference value is “yyy”, the “yyy” server appears as the 
requested server.

The “Local servers” branch shows other license servers running on your 
computer.

The “Other servers on this IP network” branch shows other license servers 
running in your IP network segment.
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About Licenses

A license conveys the right to use an application. A single license typically 
bundles one or more applications (such as IT Guru), the simulation program, 
and one or more modules. Licenses are allocated on a per-component basis. 
This means that a component that is part of a license (perhaps a module such 
as ACE) may be free and can be given to any requester, even if another 
component of the same license (most likely an application program) is in use.

A license has several associated attributes, as described below.

Table 3-1   License Attribute Definitions

Attribute Description

License number This attribute specifies the software license. A license may bundle several programs. This means 
that a single license (for example, 100/1) that includes the programs IT Guru, Expert Service 
Prediction, and Multi-Vendor Import will be shown as three separate lines in the License Manager 
interface.

Program name This attribute specifies which programs are included in the license (such as IT Guru or the ACE 
module).

Status This attribute identifies the state of the license:

• A free license (shown in green) is available to the next user who requests it.

• An in use license (shown in white) is unavailable.

• An expired license (shown as yellow with red X) is no longer valid.

License expiration This attribute is a date or the word “permanent”, depending on the type of license purchased.

Maintenance expiration This attribute is a date. It is not possible to buy perpetual maintenance.

User If the license is in use, this attribute shows the name of the user who checked out the license.

Host If the license is in use, this attribute shows the machine where the license is being used.

End of Table 3-1
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License Files

Licenses are stored in a file named license_file. There can be only one 
license file on a machine. The file is stored in one of the following directories:

Windows: <primary_hard_drive>:\OPNET_license

The <primary_hard_drive> is the first drive letter (usually C:) that names 
a non-removable, non-network local drive partition.

UNIX:/opt/OPNET_license or /var/adm/OPNET_license

The default directory is /opt/OPNET_license, which must be a local 
directory (that is, not a symbolic link or mounted across a network). If /opt 
is not local, the license server will look in the /var/adm/OPNET_license 
directory. You cannot switch between these directories or specify which one 
will be used; the software will first try /opt/OPNET_license and only if that 
directory is not usable will it try /var/adm/OPNET_license.

Loanable Licenses

Loanable licenses can be temporarily transferred from one license server to 
another, without the assistance of OPNET Technical Support. This is useful for 
providing licenses to OPNET applications that will be run on a portable 
computer or at a remote site that doesn’t have network access, without needing 
to register a license for that computer.

It is important to note when loaning a license that a “day” is defined as 24 hours. 
If a license is loaned at 10:00AM on Monday for a duration of one day, the loan 
expires on the loanee’s computer at 10:00AM on Tuesday. For loans of more 
than one day, the number of days specified is multiplied by 24 hours to 
determine the end of the loan period.

A simplified method of managing loanable licenses is built into the License 
Manager. For details, see License Operations for Loanable Licenses on 
page AG-3-11.

A more complex loanable license system is available, with additional features 
such as access lists and control of loan periods; contact OPNET Technical 
Support if you need these additional features.

Enterprise Licenses

Enterprise licenses allow OPNET applications to be used on IP networks other 
than the network in which the OPNET license server is located. Standard 
workgroup OPNET licenses require that the server and the client be used in the 
same single classful IP network.

All the standard operations apply to Enterprise licenses.
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To configure Enterprise licensing on a license server, you need the following:

• Enterprise licenses in your license server's license file.

Enterprise licenses are standard OPNET product licenses configured for use 
outside the IP network of the license server. Normally, this involves using the 
Add License operation to add licenses to your license file.

• IP Network Extensions (IPNETX) in your license server's license file.

Each IPNETX in the license file identifies an IP network to which Enterprise 
licenses are available. You administer IPNETX like a standard OPNET 
product license: you view what extensions are available to be added, then 
add them to your license file using the regular license registration process.

The purpose of IPNETX is to identify IP networks to the license server; IPNETXs 
do not get checked out for use by applications.
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Using the License Manager

This section describes how to start the License Manager and how to do License 
Manager operations.

Starting the License Manager

You can start the License Manager the following ways:

• You can start the License Manager and IT Guru in the manage license mode. 
In this mode

— IT Guru does not use a license and has only limited functions. You will be 
able to use some system menu functions, but none of the editors.

— The License Manager opens automatically.

This mode is useful when you are performing license management functions 
only. You must use this mode if you are deleting all licenses, because the 
License Manager will not allow you to delete a license that is in use.

• You can start the License Manager and IT Guru both with one command.

• You can start the License Manager from within IT Guru.

To start the License Manager from a command line, do the following procedure:

Procedure 3-1   Starting the License Manager From a Command Line

1 Launch the program (for example, itguru) with the manage_licenses preference:

<program> -manage_licenses

➥ The License Manager opens in one window. The IT Guru program opens in 
another window, but has limited functions.

End of Procedure 3-1

To start the License Manager with a script command, do the following 
procedure:

Procedure 3-2   Starting the License Manager With a Script Command (UNIX)

1 Enter the following command:

op_license_manager

➥ The License Manager opens in one window. The IT Guru program opens in 
another window, but has limited functions.

End of Procedure 3-2
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To start the License Manager from the Windows Start menu, do the following 
procedure:

Procedure 3-3   Starting the License Manager From the Start Menu (Windows)

1 Select Start > Programs > Cisco Application Analysis Solution 1.0 > License 
manager.

➥ The License Manager opens in one window. The IT Guru program opens in 
another window, but has limited functions.

End of Procedure 3-3Application Analysis Solution

To start the License Manager from within IT Guru, do the following procedure:

Procedure 3-4   Starting the License Manager from Within IT Guru

1 Launch your program (for example, itguru).

2 Choose License > License Management.

➥ The License Manager opens.

End of Procedure 3-4
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Operations

License Manager operations fall into one of three broad groups:

• License Manager operations (which are always available)

• Server operations (the server-of-interest must be selected)

• License operations (apply to a specific license or license file)

Many License Manager operations can be accessed from a pop-up menu by 
right-clicking on a server, license file, or license icon in the tree view.

Note—If a license file is in an old format and needs to be converted, all 
operations except Stop Server and Convert License File will be disabled. See 
License File Format Conversion on page AG-4-14 for more information.

License Manager Operations

Export Tree (button) Sends the information in the tree to a text file. This is useful 
for debugging.

Convert License File (File menu, button) Converts a pre-11.0 license file to a 
format the License Manager can use. After conversion, the license file will be 
unusable by pre-11.0 license servers. You should convert the license file after 
the 11.0 installation process.

Product Modules (Modules menu) Lets you specify which product options to 
use. Only the product options for which you have purchased licenses can be 
selected from the list. (Specialized model licenses are not listed here, but will be 
used at the time of running discrete event simulations.)

Server Operations

Start Server (button) Starts the selected server, allowing it to issue licenses and 
perform other license server functions. This button is active only when the 
selected server is your own (local) machine. To determine if a machine is local, 
type hostname in a shell window. See Procedure 4-4 on page AG-4-7 for 
details.

Stop Server (button) Stops the selected server. A server can be stopped even 
if running on a remote machine. See Procedure 4-8 on page AG-4-9 for details.
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Update System Date (button) Allows you to reset the license server’s date to the 
current date. Resetting the date requires that you contact OPNET via either the 
Internet, e-mail, or phone/fax. 

Note—You might need to do this operation because the server’s date is not the 
current date. This can occur even if the computer running the license server is 
set to the current date.

Set as Default Server (button) Sets user preferences so that the selected server 
is the default server. This server will be the requested server the next time you 
start IT Guru, and the values of the license_server and license_port preferences 
will be the correct ones for this server.

Refresh Server Information (File menu) Scans your network for license servers 
and rebuilds the tree.

Show Local Server’s Usage Statistics (Tools menu) Shows usage statistics for 
the local server.

Reset Local Server’s Usage Statistics (Tools menu) Resets the usage statistics 
for the local server.

License Operations

The contents of the License file are displayed when you expand the License file 
folder under a selected server. You can right-click on a license file (when it is 
expanded to show the individual licenses) and sort the licenses for that server 
by license number, product type, status, or user.

Figure 3-3   Example License File

The complete list shows every license 
in the file. Icons indicate license 
status. Here we see that some 
licenses are expired,…

some are free

some are in use, and…
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License operations are as follows. Except for the Convert License File 
operation, you can restrict who has access to these operations by creating an 
admin_auth file. If you do not create such a file, any user has access to these 
operations from any machine. See Restricting License Server Administration on 
page AG-4-11 for details.

Add License (button) Allows you to add one or more licenses to a server. 
Requires that you contact OPNET by Internet, e-mail, or telephone (voice or 
fax).

Revoke License (button) Immediately revokes a license in use. The user of the 
license receives a warning and has two minutes to save files and exit the 
application.

Change Maintenance Expiration (button) Lets you set a new maintenance 
expiration date. This date determines:

• The time period for which you have access to OPNET Technical Support.

• Which release of an application you can run. For example, suppose you have 
installed the newest version of IT Guru, which has a release date later than 
the maintenance expiration of a particular license. That license will not run 
the new release, though it will run earlier versions of IT Guru. Licenses with 
a later maintenance expiration can run the new release.

Change License Expiration (button) This button appears only if you select a 
permit that has an expiration. You cannot perform this function on a permanent 
permit.

Deregister License (button) This button removes a license from your computer. 
It is useful if the computer is about to be reformatted or decommissioned. The 
button does not appear if you have selected a permit that is in use.

Clear License File (button) This operation deregisters all licenses from the 
license file in a single operation. This button appears only if no licenses in the 
file are in use.

Register New License (Tools menu) Same as the Add License button.

License Operations for Loanable Licenses

There are several additional license operations you can use with loanable 
licenses:

• Borrow Selected License

• Extend On-Loan License

• Return On-Loan License
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• Change Authorized Loan Duration

• Change Loan Properties

Borrow Selected License (button) Borrows the selected license (which must be 
loanable) and adds it to the requested server’s license file. Use Procedure 3-5 
to borrow licenses.

Procedure 3-5   Borrowing a Loanable License

1 Make sure the requested license server is on the computer that will be using the 
loanable license. Typically, this is your local computer.

2 In the server tree-view, select one or more loanable licenses from other license 
servers. The selected licenses must be available to be loaned (green license icon 
with an “L”).

(Some license servers may not appear in the tree-view because they are on a 
different network segment or weren’t found due to network congestion. You can 
use the license_managed_servers preference to force such license servers to 
appear. See the description of this preference in Licensing Preferences on 
page AG-3-14.)

3 Click the Borrow Selected License button.

➥ If the other servers can be contacted and the licenses are loanable, you will be 
prompted for the duration of the loan. 

End of Procedure 3-5

Extend On-Loan License (button) Extends the duration of the loan for the 
selected licenses. Use Procedure 3-6 to extend a loan.

Procedure 3-6   Extending a License Loan

1 Start the License Manager on the machine that has borrowed the licenses to be 
extended (make sure it is connected to a network that can access the loaner 
machine).

2 Open the license file folder and select the license of interest.

3 Click the Extend On-Loan License button.

End of Procedure 3-6
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Return On-Loan License (button) Returns the selected licenses to the servers 
that provided them. Normally, a borrowed license will automatically disappear 
from the requester's license file and become available again in the provider's 
license file at the end of the loan period. Use Procedure 3-7 to return a license 
before the end of the loan.

Procedure 3-7   Returning a Loanable License

1 In the server tree-view, select one or more licenses that are on loan.

2 Click the Return On-Loan License button.

➥ If the loanable license provider can be contacted, the licenses are returned to it 
and removed from the local license file.

Note—In some cases, Guru may be unable to contact the license server from 
which the licenses were borrowed. This can happen if the server is known by 
several names and the name used when borrowing the license is not the name 
needed to return it. (For example, the server was known as licserv internally 
when the license was borrowed, but now must be called 
public_licserv.mycompany.com because the client is outside the network.) 
In such cases, Guru displays a dialog box requesting the server’s name.

End of Procedure 3-7

Change Authorized Loan Duration (button) Assists you in contacting OPNET to 
change the length of time for which a license can be loaned.

Change Loan Properties (button) Changes the maximum number of days for 
which the selected loanable license can be borrowed. (The maximum value set 
here cannot exceed the authorized loan duration of the license.) Use 
Procedure 3-8 to change the loan properties.

Procedure 3-8   Changing Loan Properties

1 In the server tree-view, select one or more loanable licenses. The selected licenses 
must be available to be loaned (green license icon with an “L”).

2 Click the Change Loan Properties button.

3 In the Extend Loan Period Allowed dialog box, enter the maximum number of days 
for which the selected licenses can be borrowed and click Continue.

➥ The License Manager changes the loan period for the selected licenses and 
displays a dialog box with the results of the operation.

4 Click Close.

End of Procedure 3-8
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Licensing Preferences

Licensing preferences apply to the license server or to licenses. They are 
supported by any licensed application, such as IT Guruand op_runsim. One 
additional preference, tool_name, is used to launch both IT Guru and the 
License Manager simultaneously. See Starting the License Manager on 
page AG-3-7 for details about using the tool_name preference. See the 
documentation for your product for details about the preference itself.

license_broker_host

Used with loanable license commands to specify the license broker’s host 
machine. New values for this preference take effect only at startup. Brokers are 
used only when the manage_loanable_licenses preference is TRUE.

license_broker_port

Used with loanable license commands to specify the license broker’s port. New 
values for this preference take effect only at startup. Brokers are used only when 
the manage_loanable_licenses preference is TRUE.

license_group

Specifies your group ID number, the number assigned to you by OPNET when 
you purchased the software. To find your group ID, choose About This 
Application from the Help menu. Your group ID is used when you perform 
license transactions via the OPNET web site.

Data Type string

Default Value “”

Data Type string

Default Value “”

Data Type string

Default Value “”
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license_http_proxy_password

Specifies a password to use when authenticating to an HTTP proxy server. If 
your site controls access to the Internet with an HTTP proxy server, you should 
set this preference to allow OPNET express licensing transactions to take place. 
This preference is stored in encrypted format.

license_http_proxy_port

Specifies an HTTP proxy server port to be used for express license 
registrations.

license_http_proxy_server

Specifies an HTTP proxy server to be used for express license registrations.

license_http_proxy_user

Specifies a user name to use when authenticating to an HTTP proxy server. If 
your site controls access to the Internet with an HTTP proxy server, you should 
set this preference to allow OPNET express licensing transactions to take place.

license_http_server

Specifies the web server the License Manager uses when performing license 
transactions via the OPNET web site.

Data Type password

Default Value “”

Data Type integer

Default Value 80

Data Type string

Default Value “”

Data Type string

Default Value “”

Data Type string

Default Value “licenses.opnet.com”
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license_http_use_proxy

Specifies whether to use an HTTP proxy server for express license 
registrations.

license_managed_servers

Specifies a space-separated list of <server>, <port> pairs to be explicitly 
contacted by the License Manager. This preference causes license servers that 
are not in the same IP network segment as the License Manager to appear in 
the license server tree-view. If <port> is not specified, “port_a” is assumed. For 
example: iasimov,port_a sunblade11,port_b sunblade10.

license_password

Specifies the password sent to the OPNET web server for authentication before 
beginning a license transaction. This is typically the same password you use 
when entering the User Community section of the OPNET web site. This 
preference is stored in encrypted format.

license_ping_old_servers

Specifies whether the License Manager should try to locate servers from pre-7.0 
releases of OPNET. If TRUE, the License Manager will take longer to start up 
as it looks for old license servers on the network.

Data Type boolean

Default Value FALSE

Data Type string list

Default Value <empty>

Data Type password

Default Value “”

Data Type boolean

Default Value FALSE
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license_port

Specifies the name of the communication port. This preference can have one of 
three possible values: port_a, port_b, or port_c. This preference is used in 
conjunction with license_server to uniquely identify a server running the 
licensing process and must be assigned a value.

To determine which ports are available for use by op_license_server, run 
op_license_util in port check mode on the machine where a license server 
is to be run (op_license_util -port_check). The licensing system uses 
UDP/IP ports for communication. Each port corresponds to a UDP/IP port 
(port_a is 2047, port_b is 2123, and port_c is 2345).

license_server

Specifies the name of a server that has a license file and can allocate licenses 
to clients requesting them. The server name is a string that follows the naming 
conventions supported by the TCP/IP protocol suite. This means that simple 
names (such as cbanana) and dot-separated addressing domains 
(athena.mit.edu) are supported. This preference is used with license_port to 
uniquely identify a server running the licensing process. An error will occur if a 
licensing process is not running on the specified host computer or if the host 
computer is not found. This preference must be assigned a value.

license_server_standalone

Specifies that itguru will run in stand-alone licensing mode. In this mode, the 
program acts as its own license server. Other machines cannot get licenses 
from this server. Only this single instance of the application will launch.

This preference can be used with itguru or op_runsim, but not with 
op_license_server. When this preference is TRUE, the license_server and 
license_port preferences are ignored.

Data Type string

Default Value “port_a”

Data Type string

Default Value “localhost”

Data Type boolean

Default Value FALSE
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license_server_standalone_diagnose

Specifies that itguru will run in stand-alone licensing mode and will send 
diagnostic information to the license log. In this mode, the program acts as its 
own license server. Other machines cannot get licenses from this server. Only 
this single instance of the application will launch.

This preference can be used with itguru or op_runsim, but not with 
op_license_server.

license_simple_loanable_enable

Specifies whether the license manager supports simplified loanable licensing.

license_username

Specifies the user name that will be sent to the OPNET web server during 
license transactions. Used with license_password to authenticate yourself to the 
web server.

manage_loanable_licenses

Specifies whether the license manager can communicate with loanable license 
brokers to manage loanable licenses. When TRUE, the license manager uses 
loanable license brokers to provide advanced license-management features 
such as access lists and pools. When FALSE, the simplified system of loanable 
license management described in this manual is used.

Data Type boolean

Default Value FALSE

Data Type boolean

Default Value TRUE

Data Type string

Default Value “”

Data Type boolean

Default Value FALSE
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mtn_warn_int

Specifies the interval in days between maintenance expiration warnings. These 
warnings are automatically displayed whenever you exit a program using that 
requires a license, beginning 60 days before expiration and ending when 
maintenance is renewed. The warning appears every n days, where n is the 
value of this preference, except for the period beginning 7 days before 
expiration and ending 7 days after expiration, when the warning appears every 
day.

Data Type integer

Default Value 3
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4 License Server

WARNING—Because the license format can change, your license server 
should run the latest OPNET release. A newer version of the license server can 
always serve licenses to earlier versions of the product.

op_license_server is the application that issues licenses to licensed 
applications. You may not need to directly invoke this application at all, because 
the graphical License Manager allows you to perform most common operations, 
including starting and stopping the license server. However, you may want to 
use the command line operations offered by op_license_server, perhaps 
by including commands in a script file.

op_license_server runs as a service (on Windows platforms) or as a 
daemon process (on UNIX platforms), issuing licenses to licensed applications. 
A daemon process is one that executes continuously without being attached to 
a user shell. Applications send messages to op_license_server by 
referencing its host (the workstation on which it runs) and its port (a unique 
identifier of a communications port on that host).

You can restrict who has access to certain server operations by creating an 
admin_auth file. If you do not create such a file, any user has access to any 
license operations on any server. See Restricting License Server Administration 
on page AG-4-11 for information.

You can restrict who can obtain licenses from a particular server by creating a 
user_auth file. See Restricting License Server Users on page AG-4-12 for 
details.

Licensed applications can run in a standalone or network configuration:

• In the stand-alone configuration, the licensed application itself obtains 
licenses directly from a license file.

• In the network configuration, op_license_server executes on a host 
computer that is a part of an IP network (typical for client-server 
configurations). Within a local area network (LAN), multiple executing 
instances of op_license_server can coexist, but duplicate licenses 
(licenses with the same identification numbers) are not allowed. For 
example, if one license server allocates licenses 100-1 through 100-10, 
another license server cannot allocate those same licenses.

op_license_server is typically started by one of the boot scripts of the host 
operating system. See section Stopping the License Server on page AG-4-9 for 
methods of stopping op_license_server.
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When you invoke a licensed application (such as IT Guru), the application 
sends a request for a license to op_license_server. This application 
examines the license file and, if a license is free, sends a reply granting the 
licensed application permission to run. If all licenses are in use, 
op_license_server sends a reply denying permission and the application 
notifies you.

License Server Modes

The license server has two modes: normal and diagnose. 

Normal Mode

Use normal mode for everyday operation. In this mode, the license server 
performs all of the usual functions, including writing certain events to a log file.

Diagnose Mode

Diagnose mode is not often used, because it is very verbose and creates large 
log files. However if you are debugging licensing behavior or looking for specific 
information about when and by whom licenses are checked out, then you can 
use diagnose mode.

The information generated by running the license server in diagnose mode is 
recorded to a file called license_server_log, which is located in

• Windows: <primary_hard_drive>:\OPNET_license 

• UNIX: /opt/OPNET_license 

This is the same directory where the license_file is located.

Note—The diagnose mode of the License Server writes verbose information to 
this file that will eventually create a large license_server_log. This file must be 
deleted occasionally.

To use the diagnose mode, follow the appropriate procedure:

• Procedure 4-1—Describes how to use diagnose mode on an ad hoc basis for 
either Windows or UNIX platforms.

• Procedure 4-2—Windows: Describes how to configure diagnose mode to 
start automatically when the computer is restarted. 

• Procedure 4-4—UNIX: Describes how to configure diagnose mode to start 
automatically when the computer is restarted.
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Procedure 4-1   Starting the License Server in Diagnose Mode (Ad Hoc)

1 Log in to the machine where the License Server is running.

2 Shut down the License Server. See Stopping the License Server on page AG-4-9 
for more information.

2.1 Start the OPNET License Manager.

2.2 Locate and select the License Server of interest from the left side of the 
License Manager window. 

2.3 Click the “Stop” button on the right side of the License Manager window.

➥ After a moment, the license server stops.

3 Start the OPNET License Server in diagnose mode:

Windows

3.1 Select “OPNET License Server” from the Services control panel:

Windows 2000, XP: Start > Programs > Administrative Tools > Services

Windows NT: Start > Settings > Control Panel > Services

• Right-click on the “OPNET License Server” service and choose Properties.

• Add -diagnose to the Start Parameters.

• Click on the Start button to start the License Server in diagnose mode.

UNIX

3.1 Open a c-shell.

Type the command op_license_server -diagnose &

Note—Make sure the path to the OPNET software is in your shell PATH

4 Inspect the license_server_log for the information you desire.

5 To disable diagnose mode:

5.1 Stop the License Server. 

5.2 Select the License Server of interest (in red).

5.3 Click "Start" to start the License Server in the normal mode.

End of Procedure 4-1

Procedure 4-2   Starting in Diagnose Mode for Windows (Recurrent)

1 Log in to the machine where the License Server is running.
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2 Shut down the License Server. See Stopping the License Server on page AG-4-9 
for more information.

2.1 Start the OPNET License Manager.

2.2 Locate and select the License Server (indicated by the green dot) of interest 
from the left side of the License Manager window. 

2.3 Click the “Stop License Server” button on the right side of the License 
Manager window.

➥ After a moment, the license server stops.

Note—You may need administrator privileges to perform these actions.

3 Modify the system registry. 

Note—Since you are editing your system’s registry, you should make a backup 
copy in case you need to recover.

3.1 Select Start > Run > “regedit”.

3.2 Navigate to the following key: \\My 
Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Ser
vices\OPNET License Server.

3.3 Double-click on “ImagePath”, in the right pane. 

➥ The ImagePath value appears in quotes.

3.4 Add the argument -diagnose to the end of the value (outside the quotation 
marks).

3.5 Exit the registry.

4 Start the OPNET License Server. See Starting the License Server (Preferred 
Method) on page AG-4-7.

4.1 Navigate to the Services panel.

Windows 2000, XP: Start > Programs > Administrative Tools > Services > 
OPNET License Server.

Windows NT: Start > Settings > Control Panel > Services > 
OPNET License Server.

4.2 Right-click on the OPNET License Server service, and select Start.

5 Close the Services panel.

End of Procedure 4-2

Procedure 4-3   Starting in Diagnose Mode for UNIX (Recurrent)

1 Modify the auto-boot scripts as described in Starting the License Server on 
page AG-4-7. 

2 Append the "-diagnose" flag to the command line as shown below: 
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<bindir>/op_license_server -license_port <port_name> -diagnose

Note—Fill in your own installation directory for <bindir>; substitute the port which 
defaults to "port_a" for <port_name> in the example.

End of Procedure 4-3

Preferences

Preferences enable you to configure various aspects of program operation. To 
run correctly, op_license_server must be started with the license_port 
preference. This preference specifies which one of three ports (port_a, port_b, 
or port_c) is used to communicate with an application.

Implementation in Supported Platforms

• On Windows platforms, you can change this preference by modifying the 
Registry.

• On UNIX platforms, you can change this preference by stopping 
op_license_server, then re-starting it with the new license_port value.

op_license_server supports the following preference sets:

• Standard preferences

• Diagnostics preferences

• Licensing preferences (license_port only)

For information about the Licensing preference set, see Licensing Preferences 
on page AG-3-14.

For information about other sets of preferences, see Preferences on 
page ITR-2-1 of the Guru Reference Guide.

op_license_server Preference

op_license_server also supports the following additional preference:

diagnose

This preference specifies that op_license_server run in diagnose mode, 
writing detailed information to the log file license_server_log. This file is 
located in:

• <primary_hard_drive>:\OPNET_license (Windows platforms)

• /opt/OPNET_license (UNIX platforms)
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Run op_license_server in diagnose mode only when troubleshooting the 
license server.

Data Type boolean

Default Value False
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Starting the License Server

There are several ways to start the OPNET license server. Procedure 4-4 gives 
the preferred way. The remaining procedures in this section give alternate 
methods for specific OS platforms.

Regardless of the method you use, you should note these considerations:

• You can only start the local license server (the one for the computer you are 
logged in to).

• The OPNET license server (op_license_server) must have read/write 
permissions on the license file to work correctly.

• If you installed OPNET as “standalone”, it will obtain licenses on its own. 
There is no need to start the license server in this case.

Procedure 4-4   Starting the License Server (Preferred Method)

1 Run the License Manager (as in Starting the License Manager on page AG-3-7).

2 In the License Manager tree view, select the license server for your computer. (It 
will have a red dot in front of its name, indicating that it is not running.)

3 Click the Start Server button.

End of Procedure 4-4

Windows

The following procedure gives an alternate way to start the license server on 
Windows. 

Procedure 4-5   Starting the License Server on Windows (Alternate Method)

1 Start the Services application (in the Administrative Tools section of the Windows 
Control Panel).

2 In the resulting dialog box, find OPNET License Server in the scrolling list of 
available services. If the Status column entry for this service does not read 
“Started”, select it and click the Start button.

3 The Startup column entry should read “Automatic”, which indicates that 
op_license_server will be started automatically whenever Windows is 
restarted. If this is not the case, change the Startup Type property to “Automatic”.

End of Procedure 4-5
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UNIX

There are two alternate ways to start the license server on UNIX:

• Manually, from the command line.

• Automatically, using auto-boot commands typically located in the etc/rc 
file.

Procedure 4-6   Starting the License Server on UNIX (Manually)

1 Log into the host computer where op_license_server is running.

2 Change to the binary directory (<bindir>) for your OPNET release and 
architecture.

3 Type the following command. If you do not know which port is available for 
op_license_server, enter “port_a”. If that port is unavailable, an error 
message will tell you which ports are available and you can re-enter the command 
with the correct port.

./op_license_server -license_port <port>

End of Procedure 4-6

Procedure 4-7   Starting the License Server on UNIX (Automatically

Note—Root permissions are usually required for this procedure.

1 Create the following file: /etc/rc3.d/S999_opnet_lic_server.

2 Insert the following auto-boot commands into the file you created:

# OPNET License Server
echo 'starting OPNET License Server...'
<bindir>/op_license_server -license_port <port>

End of Procedure 4-7
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Stopping the License Server

WARNING—Do not stop the license server while any licensed application is 
running, unless you will bring the license server back up within 15 minutes. For 
best system behavior, revoke all in-use licenses with the License Manager 
before stopping the license server.

Procedure 4-8 gives the preferred way for stopping the license server. You can 
also use one of the alternate methods given for specific OS platforms.

Procedure 4-8   Stopping the License Server (Preferred Method)

1 Run the License Manager (as in Starting the License Manager on page AG-3-7).

2 In the License Manager tree view, select the license file of the server you intend to 
stop and verify that no licenses are in use. 

• If any licenses are checked out, you can forcibly revoke them. To do so, select 
and revoke those licenses. The user receives a warning message and a short 
grace period, allowing time to save files and exit the application. If the user does 
not exit, the application will quit.

• You can choose not to revoke any checked-out licenses if you will bring the 
license server back up within a few minutes.

3 Click the Stop License Server button.

End of Procedure 4-8

Windows

Start the Windows “Services” application (in the Administrative Tools section of 
the Control Panel). Select OPNET License Manager from the list of available 
services and click the Stop button to stop the OPNET License Server service.

UNIX

Procedure 4-9 and Procedure 4-10 describe two alternate ways to stop the 
license server on UNIX.

Procedure 4-9   Stopping the License Server on UNIX (Alternate Method 1)

1 Invoke the License Manager program from the command line in the stop server 
mode:

op_license_util -license_server_kill -license_server <server> \
-license_port <port>
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For information about op_license_util, see the Program Descriptions chapter 
of your product documentation.

End of Procedure 4-9

Procedure 4-10   Stopping the License Server on UNIX (Alternate Method 2)

WARNING—Use this procedure only when other methods do not work.

1 Determine the process id (pid) of op_license_server by logging into the 
process’s host and using the ps command.

2 Execute the kill command from the command line:

kill <pid>

End of Procedure 4-10

License Server Log 

The license server application (op_license_server) writes messages and 
errors to a log file. The log file, named license_server_log is located in:

• <primary_hard_drive>:\OPNET_license (Windows)

• /opt/OPNET_license (UNIX)

If the log file grows too large, you can remove it even when the license server is 
running.

The type and quantity of information written to the log file varies depending on 
whether the license server is operating in normal or diagnose mode.

In normal mode, the following events are logged:

• Start up and termination of the License Manager

• Arrival of an unexpected or invalid packet from a requesting application

• Inability to read from or write to the license database

• Use of an invalid license file

• Expiration of a license

In diagnose mode, the license server logs information on the following additional 
events:

• Requesting client is not on the same IP network as the license server
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• License freed due to time-out

• License issued or refused

• Arrival of a continuation request from an application

• Arrival of a quit request from an application

• Arrival of a request to use a revoked or reissued license

Restricting License Server Administration

You can restrict access to server administration operations by creating an 
administration authorization file (admin_auth) that is stored on a specific 
license server. This file specifies machines and users: only the users listed, 
when logged into the machines listed, can perform server administration 
operations on that server. 

The following operations are restricted:

• Add License

• Revoke License (however, users who are already using licenses can always 
revoke their own licenses)

• Change Maintenance Expiration

• Change License Expiration

• Deregister License

• Clear License File

• Update System Date

• Start Server

• Stop Server

If you do not create an administration authorization file, any user from any 
machine has access to these operations.

The administration authorization file is a text file with the following format: 

<machine> <user>
...
<machine> <user>
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You can use a plus sign (+) to mean any user or any machine, as shown in the 
following example.

engineering1 root
js_pizza_box jsmith
ww_NT wwilson
+ hhoover
engineering_test +

This example file shows that:

• any user logging in as root on engineering1 can perform server 
administration operations

• jsmith can perform operations when logged into js_pizza_box

• wwilson can perform operations when logged into ww_NT

• hhoover can perform operations when logged into any machine

• any user can perform operations when logged into engineering_test

Name the administration authorization file as admin_auth and place it on the 
license server for which you want to control administration operations, in the 
same directory as the license file:

Windows: <primary_hard_drive>:\OPNET_License\

UNIX: /opt/OPNET_License/ or
/var/admin/OPNET_License/

After adding or editing an administration authorization file, you must do one of 
the following things to make it take effect:

• In the License Manager, choose Tools > Refresh Server Authorization Files.

• Stop and restart the license server.

Restricting License Server Users

You can restrict the users of a particular license server by creating a user 
authorization file (user_auth). In this file you list machine-user pairs that are 
allowed to receive licenses from that server. A license server with a user_auth 
file will grant licenses only to those machine-user pairs listed in the file.

A user authorization file is a text file with the same format as an administration 
authorization file (see Restricting License Server Administration on 
page AG-4-11 for details). Name the user authorization file as user_auth and 
place it on the license server for which you want to specify users, in the same 
directory as the license file:

Windows: <primary_hard_drive>:\OPNET_License\
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UNIX: /opt/OPNET_License/ or
/var/admin/OPNET_License/

After adding or editing a user authorization file, you must do one of the following 
things to make it take effect:

• In the License Manager, choose Tools > Refresh Server Authorization Files.

• Stop and restart the license server.

Restricting Loanable Licenses

You can restrict who can borrow particular licenses by creating a loan 
authorization file (loan_auth) on a license server. This file lists specific 
machine-user pairs and the licenses they are authorized to borrow. Users 
contacting a license server that has a loan_auth file will be allowed to borrow 
only those licenses authorized for them and the machine to which they are 
logged in. 

The loan authorization file is a text file with the format:

<machine> <user> <licenses>
...
<machine> <user> <licenses>

Machine and user are specified as described in Restricting License Server 
Administration on page AG-4-11. The <licenses> specification gives a 
license number or range of license numbers to which a machine-user pair has 
access. Licenses are identified by license number; contiguous license numbers 
can be given as a range. For example, if the following loan authorization file 
resides on a license server:

engineering1 root 1000/1-10
ww_NT wwilson 1000/3
+ + 1002/1

the following loans are authorized from that server:

• any user logged in as root on engineering1 can borrow any license in 
the range 1000/1 to 1000/10

• wwilson, logged into ww_NT, can borrow only license 1000/3

• any user, logged into any machine, can borrow license 1002/1

No other machine-user pairs can borrow licenses from this server, and no other 
licenses can be loaned by the server.
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Name the loan authorization file as loan_auth and place it on the license 
server for which you want to restrict license loans, in the same directory as the 
license file:

Windows: <primary_hard_drive>:\OPNET_License\

UNIX: /opt/OPNET_License/ or
/var/admin/OPNET_License/

If you are administering a remote license server that has a loan_auth file and 
are connected from a machine that is not allowed to borrow licenses from that 
server, some of the licenses might not appear as being loanable even though 
they really are.

License File Format Conversion

The format of the license file changed from release 10.5 to 11.0. Because of 
this, license files from pre-11.0 installations must be converted before the 
OPNET 11.0 license server can use them. After installing the 11.0 software, you 
must convert your license files by doing Procedure 4-11.

Until the license file is converted, the 11.0 license server will be unable to 
provide licenses to any 11.0 clients. (However, it can provide licenses to 
pre-11.0 clients.) After the license file is converted, 11.0 license servers will be 
able to serve licenses to both 11.0 and older license clients.

Procedure 4-11   Converting Pre-11.0 License Files

1 Start the 11.0 License Manager (as in Starting the License Manager on 
page AG-3-7).

2 In the License Manager tree view, select the server whose license file you want to 
convert. Servers with unconverted license files are marked by a yellow dot with a 
C, as shown in the following figure.

3 Click the Convert Pre-11.0 License File button and follow the on-screen prompts.

Note—More detailed instructions on how to convert a license file are posted at the 
OPNET Support Center (www.opnet.com/support); follow the License Registration 
link to the Instructions section.

End of Procedure 4-11
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